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Series 1405 TEOM Firmware Upgrade
Version 1.74.00

OVERVIEW

These instructions describe how to perform a firmware upgrade to version 1.74.00 for a
series 1405 instrument. It describes the differences between firmware versions, how to
unpack the firmware files, and how to install them on the instrument. There are two
different ways to perform a firmware update, via an Ethernet connection (with or without
a router) using ePort software or via a USB FLASH drive (for this method, see
Instrument Firmware Upgrade Instructions in this document for Ethernet-Based or USB-
Based upgrades).

IMPORTANT: For customers that haven't already updated to instrument firmware
version 1.56.00: Prior to beginning the update of your equipment to version 1.74, you
should verify the equipment has been updated to version 1.56 first. If the version
currently loaded on the unit is not version 1.56, please visit the AQI On-Line Library to
download 1.56 and refer to the readme file for version 1.56 for upgrade instructions.

If you fail to update to 1.56 and try to go straight to version 1.74 you may encounter an
unrecoverable error requiring you to replace the compact flash card.

PLEASE NOTE: It may be necessary to temporarily disable the Windows Firewall prior
to upgrading firmware to resolve connection issues when upgrading.

INSTRUMENT FIRMWARE VERSION RELEASE NOTES

Version 1.74.00 changes from version 1.73.00:

Changes common to all product variants
e Add fix to properly calculate the PMT10 values based on standard conditions.

Version 1.73.00 changes from version 1.72.00:

Changes common to all product variants

e Set time screen now has limits on the hour’s value of 0-23 (was 1-24).

e Added warning screen to inform user that the unit must be in Stop mode to set the
time. Unit now reboots automatically when the time is changed.

e Changes to the boot-up scripts to accommodate new Kontron processor board
hardware.
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Version 1.72.00 changes from version 1.71.00:

Changes common to all product variants
e Bug fix: address clock drift by synchronizing with onboard precision clock.

Version 1.71.00 changes from version 1.70.00:

Changes common to all product variants

e Fix the delay in COM port transmission for AK and German Network Protocols.

e Remapped the Operational Status codes from the standard 1405 definitions to ones
compatible with the German Network Protocol.

Version 1.70.00 changes from version 1.57.00:

Changes common to all product variants

e New Feature added to Implement German Network Protocol

e New Feature added to Update Instrument GUI and add registers support to reflect
updated EPA FEM Status

e Bug Fix: Enhance the stability of SSTO AK Protocol command.

e The AK Protocol PRC set was extended or modified to correspond with the changes
described.

e Add Default Gateway item in network configuration

The following are new, added PRCs:

PRC Description

421 German Network Protocol Instrument ID
422 German Network Protocol Location ID
423 German Network Protocol Registers to Read
424 German Network Protocol End Character
425 Coarse FEM MC Value

426 Coarse FEM MC Value 30 mins

427 Coarse FEM MC Value 1 hour

428 Coarse FEM MC Value xx hours

429 Coarse FEM MC Value 12 hours

430 Coarse FEM MC Value 24 hours

431 Total FEM MC Value

432 Total FEM MC Value 30 mins

433 Total FEM MC Value 1 hour

434 Total FEM MC Value xx hours

435 Total FEM MC Value 12 hours

436 Total FEM MC Value 24 hours

437 Default Gateway
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Version 1.57.00 changes from version 1.56.00:

Changes common to all product variants

The version numbers for various software components for the prior release and this
release are a follows:

software component instrument version 1.57 | instrument version 1.56
bootloader 1.4* 1.3
ePort firmware update script | 1.2 1.1
USB firmware update script | 1.2 1.1

* Only for factory units manufactured after version 1.57 of the instrument software
was released.

Enhancement that should improve the overall reliability and performance of the
instrument by updating some of the underlying packages used (kernel, graphics,
database, drivers). Similar enhancement that improves the reliability and
performance of the data storage (Compact Flash) by reconfiguring the driver.
Correct a minor memory usage bug.

This instrument firmware update contains a new release of board firmware for the 10
Interface board. The new version is 0.014 and in most cases will auto-update from
version 0.013. Please watch for the update the first time booting the instrument
after the instrument firmware update. Refer to the section above about board
firmware updates. |0 Board firmware version 0.014 provides a bug fix for an
automatic input calibration problem.

New feature added for ambient Relative Humidity (RH), dryer RH, and dryer
temperature calibration (dryer fields are only on the FDMS variants). The calibration
steps for these measurements now include a correction offset that is factored into
the control, thereby improving instrument performance. A new set of corresponding
Product Register Codes (PRCs) have been added, while maintaining backward
compatibility with the existing PRCs. See the PRC table below for the new codes.

Enhancement to the KO audit wizard feature that displays the initial and final
frequency values used in the calculation displayed on the results screen. These
values are now displayed in new fields along with the fields that are currently being
displayed, which are the pass/fail status and the KO percent difference calculation.

Enhancement to the USB-based data download feature that adds a header with
additional information at the beginning of the .CSV file that gets created. This header
information will now be the same as in .CSV files offloaded using the ePort client
software. Also, the file names that are created will be named using unique identifiers
that include the instrument serial number and follow the ePort downloaded file
naming convention. Using the same naming convention will help eliminate confusion
and errors especially when working with data files from multiple instruments. The
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convention is SN_YYYY-MM-DD_HH-MM-SS.csv, where SN is expanded to be the
instrument’s serial number, YYYY is the year, MM is the month, DD is the day, HH is
the hour (24 hour format), MM is the minutes and SS is the seconds.

e Enhancement that improves the instrument’s network security by improving telnet
protocol security.

e Enhancement to the flow audit wizard feature that adds a total flow field. This new
total flow field value represents the combined values of the individual flows. The total
flow is also available as a selectable audit similar to the existing flows. The results of
the total flow audit will be displayed on the results screen, in addition to the
individual flows as they are currently being displayed. At the end of the audit, the
user has the option of applying an adjustment factor for the individual flows, but not
the total flow. Note that it is recommended that users audit the individual flows first,
before auditing the total flow.

e Enhancement to the flow audit wizard feature that displays the adjustment factor
value in a new field on the completion screen.

e Bug fix to correct an issue where the flow audit adjustment factor was retained and
used during a subsequent flow calibration. This issue only affected customers who
utilized the flow audit adjustment factor function during the flow audits. When
performing a flow audit, the operator has the ability to accept the use of a flow audit
adjustment factor as a single point calibration adjustment for the instrument flow
rates. In previous versions of the instrument software, the flow audit adjustment
factor was retained and used during and after a new flow calibration. With this
updated version, the audit adjustment factors are now reset to 1.0 and are not used
during a flow calibration. During subsequent flow audits after a flow calibration, the
audit adjustment factor is updated relative to the previous flow calibration and not
the previous flow audit. This allows for a more consistent review of the flow
calibration and audit results and allows for a better historical review of changes in
the flow calibrations and audits of the instrument.

e Bug fix for problem where after performing an instrument firmware update using the
USB-based update method, configuration changes in the Contact Closure feature
(Settings > Analog & Digital Outputs > Contact Closure) would not be retained.
Instead of being saved, those configuration items would revert back to their default
values.

e Bug fix in the Leak Check Wizard feature for a problem where it incorrectly reported
that the check was successful but one channel had failed.

e Bug fix to handle rare instances where a specific type of data on the Ethernet
network could misinterpreted by the instrument, causing it to attempt to modify it's
data logging interval with an invalid value. This would in-turn cause the instrument to
stop logging data because the invalid value was not being handled correctly. There
were two associated bug fixes for this. The first was to prevent the data logging
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feature from being susceptible to the specific network data. The second was to limit
the logging interval entry to 28,800 seconds (8 hours) at most.

Removed a feature that provided a level of internationalization for number formatting
(decimal point or comma representations) because it was not working properly. The
feature may be included in a subsequent release.

The PRC set was extended or modified to correspond with the changes described.

The following are new, added PRCs:

PRC Description
401 Dichot mass conc standard
402 Dichot 30-min mass conc standard
403 Dichot 1-hr mass conc standard
404 Dichot XX-hr mass conc standard
405 Dichot 12-hr mass conc standard
406 Dichot 24-hr mass conc standard
407 TEOMA mass constant A
408 TEOMA mass constant B
409 TEOMB mass constant A
410 TEOMB mass constant B
411 TEOMA dryer temp offset
412 TEOMB dryer temp offset
413 TEOMA dryer temp raw
414 TEOMB dryer temp raw
415 ambient RH offset
416 TEOMA dryer RH offset
417 TEOMB dryer RH offset
418 ambient RH raw
419 TEOMA dryer RH raw
420 TEOMB dryer RH raw
The following are renamed PRCs.
PRC New Description Old Description
036 Dichot mass constant A | mass constant A
037 Dichot mass constant B | mass constant B

Changes specific to the —Dichot (non-FDMS) product variant

Enhancement to the mass calculation constants feature that adds two new sets of
configurable constants. The new sets of mass constants are for the PM 2.5 and PM-
coarse measurements. Both new sets of constants are accessible on the Mass
Calculation Variables screen (Settings > Advanced > Mass Calculation Variables
> Mass Constants). Each set of constants are independently applied. Currently
there is only a single set of mass constants for PM-10. Note that the PM-2.5 and
PM-coarse constants are applied before the PM-10 constants are applied. Two new
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pairs of corresponding PRCs have been added, while maintaining backward
compatibility with the existing PRCs. See the PRC table above for the new codes.

Changes specific to the —Dichot product variants (both FDMS and non-FDMS):

e Enhance the PM-10 Mass Concentration measurement reporting by providing the
ability to change the associated settings between the actual and standard condition
settings. This is independent from the PM-2.5 and PM-coarse measurements.
Currently there is only one reporting setting that is applied to all of the
measurements. A new set of corresponding PRCs has been added, while
maintaining backward compatibility with the existing PRCs. See the PRC table
above for the new codes (the ones with “standard” in their names).

Changes specific to the FDMS product variants (both SingleFDMS and DichotFDMS):

e Bug fix to correct an error where the 1 hour average values were not properly
synchronizing with the top of the hour recording. When recording hourly data, there
were occasions where the hourly update occurred after the hour data update. This
resulted in duplicate hourly data values. If data was recorded at a more frequent
data rate, the hourly update is recorded at the next data period, prior to the start of
the next hourly reporting period.

e Bug fix for a problem where non-default FEM configuration settings (Settings >
Advanced > Mass Calculation Variables > Equivalent Designation) were not
retained across a power cycle.

Changes specific to the non-FDMS product variants (both Single and Dichot):

e Enhancement to the mass calculation variables feature that adds two new
configurable mass averaging constants. The two new constants are for the total
mass averaging time and the MRMC averaging time. These items can be configured
on the Mass Calculation Variables screen (Settings > Advanced > Mass
Calculation Variables). Both settings have a default value of 300 seconds and a
range of 10 to 20,000 seconds inclusive. In the prior version, the MRMC setting
range was 0 to 1,000 seconds inclusive. A value of 1500 for these constants will
allow the instrument to mimic the averaging behavior of the previous TEOM model
1400ab.

Version 1.56.00 changes from version 1.55.00:

Changes common to all variants:

e Add feature to align the data logging (Settings > Data Storage) updates with the
top-of-the-hour when possible. For example when using even, align-able data
storage intervals such as 1 Hour, 30 Minutes, 10 Minutes, etc., data logging updates
will be aligned with top of the hour (align-able intervals are required so for example
using odd values such as 7 Minutes will not align). To illustrate this, the following
table from a data file offloaded from an instrument shows top of the hour alignment
using a 1 hour data storage interval setting:
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time_stamp tmoTEOMAMC 0 tmoTEOMAMC1Hr 0

04/18/2011 20:00 0.0 0.0
04/18/2011 21:00 3.52034 0.8892
04/18/2011 22:00 0.382882 1.10901
04/18/2011 23:00 -2.2713 -0.423206
04/19/2011 00:00 1.80596 -0.020079
04/19/2011 01:00 1.52067 0.768729

In this example, the instrument data was cleared and the instrument was booted
prior to 20:00 (between 19:00 and 20:00). The instrument won'’t log data until the
top-of-the-hour and the logged values are populated just prior to the top-of-the-hour
boundary. So not only is the data logging synchronized with the top of the hour, but
the calculations are synchronized as well. In the prior version, the time stamps in the
first column would be from whenever the instrument happened to have been started.
As shown, in order to provide this feature, it is necessary to delay the startup
sequence until it is in alignment, so users may notice this additional startup time.

e Detect humidity and temperature sensor failures even if unit is not configured for
active control flow and set the corresponding Status Condition error code.

e Fix problem where data logging in some cases would start before the correct Real-
Time Clock time value was read. This was limited to within the first minute after the
instrument was powered on.

e Several increase-reliability types fixes.

¢ Removed an unused entry on the list of selectable Data Logging variables.

e Edit one of the PRC codes by renaming a reserved register to be the "MRMC
average time" PRC (compatibility with version 1.55 is maintained).

Changes specific to the SingleFDMS variant:
e Enhancement to add U.S. EPA Federal Equivalent Method (FEM) support that
includes an updated main screen with a new column and populated FEM variables.

Changes specific to the Dichot (non-FDMS) variant:

e Correctly account for a 10% loss of mass flowing through fine channel at the inlet in
all the Coarse Mass Concentrations (both real-time and averages). Previously this
loss adjustment was not being applied.

Version 1.55.00 changes from version 1.52.00:

Changes specific to the Single and Dichot (non-FDMS) variants:
e Modify the Mass Concentration output to have a less smoothed response that is very
close to that of the 1400.

Changes specific to the Single variant:

e Correct the operation of the Mass Calculation constants (Settings > Advanced >
Mass Calculation Variables), in the prior release these weren’t functional. Also
change the default values for these to match the 1400, so Mass Constant A will be
3.00 and Mass Constant B will be 1.03 by default.
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Changes common to all variants:

e Correct the Touchscreen calibration reboot screen to place the buttons where they
are accessible on the screen even when the instrument is in a mis-configured
calibration state and the user is attempting to correct it.

e Update the bootloader to version 1.3 to correct a minor recoverable error that
occurred during an ePort firmware update under some situations (only new
production units or customers that update their Compact Flash card will get this
specific/bootloader change).

Version 1.52.00 changes from version 1.51.00:

Changes common to all variants:

e Add Touchscreen configuration (Service > Calibration > Touchscreen
Calibration) used to select between pre-calibrated configurations for the new model
touchscreen (Berquest P/N 400456-01, which has a brown colored ribbon cable) and
the old model touchscreen (Berquest P/N 400212-02, which has clear colored ribbon
cable). Thermo Scientific recommends that all customers please read the associated
Tech Note about touchscreens called “Series 1405 TEOM Touchscreens Technical
Bulletin”. This will be of particular interest to customers that have experienced
touchscreen mis-alignments on instruments, but all customers will want to read it
and possibly will need to follow a short procedure.

e Update touchscreen vendor driver software to version 3.04d.

e Correct operation of analog anemometer via 1/0O board firmware version 0.013.

e Bootloader update to version 1.2 (minor update, on new instruments only)

Changes specific to the Dichot variant:

e Correct a problem where if non-default values for the Mass Constants (Settings >
Advanced > Mass Calculation Variables) were used, they were incorrectly being
applied twice. The default value for Mass Constant A is 0.0 and the default value for
Mass Constant B is 1.0.

Changes specific to the DichotFDMS variant:

e The instrument reboot (Service > Run Control > Reboot) via the graphical user
interface should function correctly. Note: There’s a small delay when it power cycles
the circuit boards in the system when rebooting.

Version 1.51.00 changes from version 1.28.00:

Changes common to all variants:

e Enhancement adding an instrument variable ordering feature that allows a customer-
defined ordering to appear within data files offloaded from the instrument. The left-
to-right column ordering in the spreadsheet data files will correspond to the top-to-
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bottom ordering specified on the Data Storage screen (Settings > Data Storage).
See the on-screen instructions and the 1405 Operating Guide for more information.
Also see the release notes section below for the ePort and RPComm Thermo
Scientific applications.

Correct problem where occasionally, especially after quickly entering Stop or Setup
mode and then back to Run mode, the instrument would enter Stabilization mode as
expected but not exit it. On the SingleFDMS and DichotFDMS variants, the
instrument may have continued to correctly calculate the Mass Concentration values
when in this state, but in some cases it may not for example the Base Mass
Concentration for Side A may have an opposite/negative signed value vs. expected.
Also, the noise values may incorrectly appear as zero when the instrument is in this
state.

Correct problem that was preventing ePort from obtaining diagnostic information
from the instrument. This feature is accessed on ePort’'s Help menu (Help >
Download Diagnostics) and is used to obtain items such as information status logs
and board firmware revision levels for the various circuit boards in the instrument.
Add startup message to display the Bootloader version level when the instrument
powers up. Remove unnecessary startup messages.

Changes specific to the DichotFDMS and SingleFDMS variants:

Correct a problem where the Leak Check Verification feature could potentially
damage a value under some circumstances (when the Leak Check Verification is
running and the stabilization timer has expired and a 6-minute valve switch event
occurs).

Enhancement to the Leak Check Verification feature (Service > Verification > Leak
Check) that allows each TEOM side to be independently checked for leaks. The
new results screen shows additional information (the zero level measured and the
pass/fail threshold limits) and displays results for both sides (if both sides were
tested).

Correct a problem where the main data screen and the “FDMS Module” screen
Dichot “total” columns unexpectedly contained non-zero values, unlike the other
columns that get zeroed correctly, when the instrument mode is changed from Run
to Setup or Stop mode.

Correct problem where if the Leak Check Back button (Service > Verification >
Leak Check) was used when the stabilization timer was running, it would sometimes
produce a timer-related exception error message.

Added U.S. EPA Federal Equivalent Method (FEM) related PRC codes to the set of
supported codes for use with RPComm. The updates are entries appended to the
end of the PRC codes list so the list should remain backward compatible.

Changes specific to the DichotFDMS variant:

Enhancement to add U.S. EPA Federal Equivalent Method (FEM) support that
includes an updated main screen with a new column and new instrument variables.
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Note: Initially this feature is only for the DichotFDMS variant but a future release may
provide support for the SingleFDMS variant.

The new instrument variables parallel the existing PM sets so there are instrument
variables for the FEM Mass Concentration and the various FEM Mass Concentration
averages. The new variables follow the same naming convention but instead have
the “TEOMA FEM” prefix. A new configuration button is used to select between the
default calculations mode (as in earlier versions, using the “none” selection) and with
the new additional FEM calculations mode (using the “EPA” selection). This
configuration item is on a new Equivalent Designation screen (Settings > Advanced
> Mass Calculations Variables > Equivalent Designation). Note: there are
Equivalent Designation buttons for “TUV”, “Japan” and “Other” but these are not
supported at this time.

Changes specific to the Dichot variant:

Corrects the KO Verification Wizard (Service > Verification > Mass Transducer KO
Verification) title and description text.

Version 1.28.00 changes from version 1.27.00:

Back-off and separate the vacuum warning thresholds because the vacuum warning
enhancement added in the prior release was causing warning messages too soon at
some installations on some variants. The new vacuum warning thresholds are 0.4
atm for the FDMS variants and 0.75 atm for the non-FDMS variants.

Version 1.27.00 changes:

Note: Version 1.25.00 was the last official release for the FDMS variants, and it had
limited scope. Prior to that, V1.23.00 was the last official release for the FDMS variants.
Version 1.22.00 was the last official release for the non-FDMS variants.

Changes common to all variants:

Correct the way the Filter Loading is calculated to factor in elevated altitude
conditions.

Change the vacuum warning determination method to better detect warning
conditions and change the corresponding warning message. The warning appears
when the Vacuum Pressure > 0.3 atm instead of when the Ambient Pressure —
Vacuum Pressure < 0.1 atm.

Add detection that the external Relative Humidity/Temperature sensor is not
connected and add a corresponding warning message. The hexadecimal system
warning code for this warning is 0x00000008. The sensing is dynamic so it will
detect sensor installation/removal changes while the instrument is running. Note that
this check only takes place when the flow control is set to Active (Instrument
Conditions > Flows > Flow Control > Volumetric Flow Control = Active).
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Changes specific to the DichotFDMS and SingleFDMS variants:

Constrain the Frequency Wait time values (Settings > Advanced > Mass
Calculation variables) that the user can enter to be one of the following, in
seconds: 60, 70, 80, 90.

Changes specific to the SingleFDMS variant:

On the Single-FDMS variant only, on the Cooler Cleaning Wizard (Service >
Maintenance > Clean Coolers), correct a problem where, after stabilizing at 50 °C,
the wizard should have started a 1-minute countdown timer to allow the system to
stabilize, this step was being skipped.

Version 1.25.00 changes from version 1.23.00 are:

SingleFDMS and DichotFDMS variants only (note: version 1.23.00 was the last official
release for these variants):

Reduce the likelihood of a TEOM dryer dew point warning that was being activated
too soon under some ambient conditions. Changed the method of determining if a
warning condition exists to: dryer dew point is greater than the cooler temperature
set point minus 2 °C, from: dryer dew point is greater than 2 °C.

Correct problem where occasionally, especially after quickly changing modes from
Run to Stop or Setup mode back to Run mode, the instrument would enter
Stabilization mode as expected but not exit it. The instrument may or may not
continue to correctly calculate the Mass Concentration values when in this state. In
at least one instance the Base Mass Concentration value for the PM-2.5 flow path
was observed to have an opposite/negative-signed value vs. expected.

Version 1.23.00 changes from version 1.22.00 are:

SingleFDMS and DichotFDMS variants only: Mass Concentration calculation
algorithm timing value change related to the TEOM(s) to further improve the
temperature stability of the instrument when combined with other associated
mechanical changes.

Version 1.22.00 changes from version 1.21.00 are:

Single and Dichot variants only: Make the mass concentration algorithms equivalent
to the ones in the 1400ab instrument, including: a) software changes combined with
other changes to eliminate the rare occurrence of a mass-measurement temperature
sensitivity, b) mass concentration hourly average updates aligned with the top of the
hour, ¢) 300 second mass averaging interval vs. 120 seconds.

SingleFDMS and DichotFDMS variants only: Make the mass concentration
algorithms equivalent to the ones in the 8500c instrument, including: a) software
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changes combined with other changes to eliminate the rare occurrence of a mass-
measurement temperature sensitivity, b) lower noise levels due to better calculation
methods, c) mass concentration hourly average updates aligned with the top of the
hour.

Version 1.21.00 changes from version 1.20.00 are:

¢ On Dichot variant only, correct a problem where the mass constants were incorrectly
being applied at the Fine and Coarse mass concentration calculation stages. The
change is to only apply the A and B Mass constants after the Dichot calculation that
sums the Fine and Coarse values for PM-10.

Version 1.20.00 changes from version 1.19.00 are:

e Align the PRC codes, which are used by RPComm software and data loggers, to
make the codes on the non-Dichot-FDMS variants match the codes on the Dichot-
FDMS variant. Add a new PRC code at the end (“instrument time”, PRC code 390)
to provide the instrument’s current time (The time is expressed in seconds since the
Epoch, which is 00:00:00 UTC, January 1 1970.).

e Created a 1405 register configuration file for use with RPComm. A single
configuration file is common to all model variants. See section below about how to
install this new configuration file for use with RPComm.

e Correct problem where the Maintenance Schedule screen date field was not visible
(without a reboot) after changing the Display background color setting.

e Change the Ambient Pressure field on the display (Instrument Conditions > Ambient
Conditions screen) to have 3 decimal points instead of 2.

e Change the file extension on data files downloaded via the USB port on the
instrument to be “.csv” instead of “.txt".

Version 1.19.00 changes from version 1.18.00 are:

e Correct problem on the 1405-Dichot model variant where the Mass Rate and Mass
Concentration values were being calculated incorrectly.

Version 1.18.00 changes from version 1.17.00 are:
e Correct problem on the 1405-Single model variant where the Mass Rate and Mass
Concentration values were being calculated incorrectly.

Version 1.17.00 changes from version 1.16.00 are:

e Correct problem on the 1405-Single and 1405-SingleFDMS variants where the KO
Verification Wizard hangs waiting for the frequency to stabilize.

e Minor update to the KO Verification Wizard screen messages to match the Operating
Guide manual, for all model variants.
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INSTRUMENT FIRMWARE - FILE UNPACKING INSTRUCTIONS (DOWNLOADS)
The updated instrument firmware is available either by a download from the Thermo
Scientific Air Quality Instruments Online Library or a Thermo Scientific 1405 CD (when
requested from Thermo Scientific Technical Service). If the CD media is used, this
section should be skipped since the instrument firmware files are already
uncompressed, instead proceed to the “INSTRUMENT FIRMWARE - UPGRADE
INSTRUCTIONS” section below to install the firmware update.

Requirements:

e A PKZIP-compatible uncompression program is required, such as WinZIP or 7-Zip.

e Approximately 25MB of free disk space (per variant, in the unusual case that more
than one is variant instrument is being updated) available.

Firmware package file unpacking instructions:

1.Using the table below, identify the instrument firmware package upgrade file. Each of
the instrument model variants (1405-Single, 1405-Dichot, 1405-SingleFDMS, 1405-
DichotFDMS) are upgraded using a different file as shown.

Note: In this example, a Dichot-FDMS variant firmware package is being extracted.
IMPORTANT: Make sure you have the correct firmware for the model variant of the

instrument you are updrading (see table below). If you perform an upgrade using
firmware intended for a different model, the instrument will not operate correctly.

1405 model variant Instrument firmware package filename
Dichot FDMS — 1405DF | 1405-DichotFDMS_v017200.zip

Single FDMS - 1405F 1405-SingleFDMS_v017200.zip

Dichot — 1405D 1405-Dichot_v017200.zip

Single — 1405 1405-Single_v017200.zip

2.0n Windows, start the 7-Zip File Manager.

3.Navigate to the directory in which the instrument firmware package resides, just like in
the Windows File Manager.
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P:\1405\1405 Contrel Software\1 72\1.72RCI\ =N R (==
File Edit View Favorites Tools Help

N .

Add Edract Test Copy Move Delete Info

5 3 P:\1405\1405 Control Software\1.721.72RC1\ A
Name Size  Modified Created Accessed Attributes Packed Size Comment
1405 2015-08-1817:51 2015-08-1812:22  2015-08-18 17:51 ) 0
14050 2015-08-1817:52 201508181222 2015-08-1817:52 D 0
1405DF 2015-08-1817:52 2015-08-18 12:22 2015-08-18 17:52 D 0
14057 2015-08-1817:53  2015-08-1812:22  2015-08-18 17:53 D 0

0 object(s) selected

4.Select the directory in which the instrument firmware package resides, then either
double-click on it or click File > Open. The Open Archive dialog box should appear.

P:\1405\1405 Control Software\1.72\1 J2RCI\1405\ =N ECR =)
File Edit View Favorites Tools Help

Y L

Add Edract Test Copy Move Delete Info

: P:\1405\1405 Control Software\1.72\172RC1\1405\ -
Name Size  Medified Created Accessed Attributes Packed Size Comment
11405 READ ME First pdf 760753 2015-08-1616:14 2015-08-1816:47 2015-08-18 16:47 A 760753

1, 1405-Single v017200.zip 27685547 2015-08-1817:51 2015-08-1817:49 2015-08-1817:50 A 27685 547

| checkv1s2 8024 2015-08-180911 2015-08-1812:22 2015-08-1812:22 R 8024

| etx_single kemel 1379320 2015-08-1808:11 2015-08-1812:22 2015-08-1812:22 R 1379320

| ete_singletar 84559360 2015-08-1809:11 2015-08-1812:22 2015-08-1812:22 R 84559 360

| etx_single_ePort.rc 2636 2015-08-180911 2015-08-1812:22 2015-08-1812:22 R 2636

| ebe_single_USB.rc 6386 2015-08-180911 2015-08-181222 2015-08-1812:22 R 6386

| RP14051.72 15321 2015-03-04 1548 2015-08-1815:24 2015-08-18 15:24 A 15321

0 object(s) selected

Note: the time stamps and file sizes may be slightly different from as shown.
5.Select all of the files, then click Extract. The Extract dialog box should appear.

6.Navigate to the desired extraction directory (or enter in a directory name directly in the
“Extract to” data entry field) then click the OK button. An Extracting message box
should be displayed while the files are bring extracted. The files shown should have
been extracted into the selected extraction directory, for a —Single variant in this
example.

7.Click File > Exit to exit the 7-Zip File Manager.

INSTRUMENT FIRMWARE - UPGRADE INSTRUCTIONS (ETHERNET-BASED)
Follow these instructions to update an instrument's firmware using an Ethernet
connection and the ePort application software.

Ethernet-based firmware upgrade procedure:
1. Unpack the correct firmware files as described in the unpacking section above.

2. The firmware update process should automatically backup and restore the
configuration, but just in case anything goes wrong, record a couple of important
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factor settings. Record the KO value(s) on the screen “Settings” > “Advanced” >
“Mass Transducer KO Constants”, and the Serial Number on the “Settings” >
“Advanced” > “Serial number” screen.

3. IMPORTANT: Also, please offload any required data files that the instrument is

currently holding because they will be deleted when the new firmware is installed.

4. The next set of steps actually update the instrument firmware and are described in
more detail in the 1405 TEOM Operating Guide for the instrument model, in the
Installing New Firmware section. It is recommended you refer to that in addition to
the steps are outlined here. The instrument’s configuration will be backed-up and
restored during the process.

a.

On the “System Status” screen of the instrument being updated, locate
and record the values for the “Serial number” and “IP address” fields. If
there is no IP address or if networking needs to be setup on the
instrument, refer to the network configuration section at the end of this
procedure. The next steps refer to ePort.

Open ePort and select the “Open Saved Configuration” option if one
exists or the “Find Samplers” option, and then click the “OK” button.

On the list of recognized instruments on the left side, find the entry that
matches the Serial Number noted for the instrument to upgrade, and click
it once to select it (it should become high-lighted). Once selected, on the
center status field, it should display the IP address associated with the
instrument and that should match the IP address noted.

Find the “Upgrade Instrument Firmware” menu item and click it (On ePort
version 1.4.1, the “Upgrade Instrument Firmware” menu item is on the File
menu, File > Upgrade Instrument Firmware, and on earlier versions it is
a button on the main screen). The 1405 Installer Wizard screen should
appear. Click the “Next” button to continue.

Use the following table to identify the script file name that will correspond
to the instrument model variant being upgraded. The script file is the one
with the .rc extension and is shown in bold font. The other files shown in
the same row are the other necessary firmware files.

1405 model variant firmware files (ePort-based)

etx_dichotFDMS_ePort.rc
Dichot FDMS — 1405DF | etx_dichotFDMS .kernel
etx_dichotFDMS.tar

Single FDMS — 1405F etx_singleFDMS_ePort.rc
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etx_singleFDMS .kernel
etx_singleFDMS.tar

etx_dichot_ePort.rc
Dichot — 1405D etx_dichot.kernel
etx_dichot.tar

etx_single_ePort.rc
Single — 1405 etx_single.kernel
etx_single.tar

Note: The ePort update script fle names have changed since the prior
release, so they can be more easily distinguished from the USB-based
update scripts.

Important: Be sure to use the correct update script or the instrument may
not operate correctly afterwards.

Next to the “Choose File to Upload” text box, click the “Browse” button.
Navigate to where the firmware files were extracted and select the .rc
script file from the table by clicking it, then click the “Open” button.

g. Back on the installer dialog box, click the “Next” button to continue and the
firmware update should begin. Once the software update process starts,
do not interrupt it or the instrument may not operate correctly.

h. When the Installer screen displays the message “Restarting instrument
— This may take a few minutes”, watch the instrument if possible and it if
does not automatically reboot after 1-2 minutes (the screen will also
continue to display this “Restarting Instrument” message), manually power
cycle the instrument at that point. After the instrument reboots, the
“Restarting Instrument” message on ePort should change when detected.

i. The Upload Progress screen should be displayed next as the update
process continues, it will take approximately 5-15 minutes. After it reaches
100%, a “Software Update Completed” message should be displayed.
Click the “Finish” button to exit the Firmware Installer. The instrument
should reboot automatically and should have the new firmware installed.
To check, see on the “Instrument Status” screen that the “Instrument
firmware version” field shows “1. 72"

Note: Once the instrument restart after the instrument firmware update,
most installations will see an automatic firmware update for one of the
circuit boards. This is because version 01.72.00 contains an embedded
instrument firmware update for one of the circuit boards, an update to
firmware 0.014 for the I/O board. See the end of the Overview section
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above about board firmware updates and be sure not to interrupt the
firmware update.

j. Later, after all installation steps have completed successfully including the
RPComm register configuration file installation steps (below, if needed),
the firmware upgrade files that were extracted into a temporary work area
may be deleted.

INSTRUMENT FIRMWARE - UPGRADE INSTRUCTIONS (USB-BASED)

IMPORTANT: Instrument firmware update using a USB stick requires instrument
firmware version 1.51.00 or greater (the full version, see the highlighted section on the
1%' page). This is because instrument firmware version 1.51.00 contains Bootloader
V1.1 which is necessary for the instrument to recognize the USB stick. Without
instrument firmware version 1.51.00, the instrument will ignore the USB firmware update
steps and boot normally.

It is recommended that the user read through all these steps prior to starting the actual
firmware upgrade.

Requirements:
1. A Phillips screwdriver.

2. A USB stick formatted using the FAT file system, non-write-protected, with
approximately 100MB free space (per variant-type to be updated, in the unusual
case where more than one variant instrument is being updated) is required.

Note: While there are many different types of USB devices that could be used for the
USB-based firmware update, the recommended device is a standard USB FLASH drive
device. USB hard drives and other USB devices might work but in some cases the 1405
may not supply enough current to power them, or may not correctly recognize them, so
a small standard FLASH drive device is recommended.

Notes about the upgrade process:

1. The 1405 instrument firmware files are named in such as way as to allow the
firmware for all variants to be copied to a single USB stick without naming collisions.
For customers with different variants of instrument to update, the firmware for all
variants to be upgraded may safely be copied to a single USB stick.

2. During the upgrade process, backup configuration files from the instrument are
saved to the USB stick in order to restore them later during the upgrade. Since this
configuration is good to have in case it somehow gets lost, the configuration
backups are not deleted after the upgrade is complete (if you wish to, you may
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manually delete them after). Configuration backups are saved for both the current
configuration and the last configuration backup. The configuration files are backed-
up on a per-variant basis so they won’'t over-write each other (in the unusual case
where more than one instrument is being updated using a single USB stick). The file
names used are in the form {variant} NV_Settings.tar where {variant} is the name
corresponding to one of the variants (“dichotFDMS”, “singleFDMS”, “dichot” or
“single”) for the most recent backup and {variant} NV_Settings_OLD.tar for the older
backup. The file format used is the Linux tar file format.

USB-based firmware upgrade procedure:
1. Unpack the correct firmware files as described in the unpacking section above.

2. The firmware update process should automatically backup and restore the

configuration, but just in case anything goes wrong, record a couple of important
factor settings. Record the KO value(s) on the screen “Settings” > “Advanced” >
“Mass Transducer KO Constants”, and the Serial Number on the “Settings” >
“Advanced” > “Serial number” screen.

. IMPORTANT: Also, please offload any required data files that the instrument is
currently holding because they will be deleted when the new firmware is installed.

. Copy the 1405 instrument firmware files for the instrument to be updated onto the
USB stick using Windows Explorer or another means. The necessary files for a
given variant of the 1405 instrument are listed below. They must be copied into the
root directory of the USB stick’s file system otherwise they won’t be recognized.

1405 model variant firmware files (USB-based)

etx_dichotFDMS_USB.rc
etx_dichotFDMS .kernel
etx_dichotFDMS.tar
checkvl152

etx_singleFDMS_USB.rc
etx_singleFDMS.kernel
etx_singleFDMS.tar
checkv152
etx_dichot_USB.rc
etx_dichot.kernel
etx_dichot.tar

checkv152
etx_single_USB.rc
etx_single.kernel

Dichot FDMS — 1405DF

Single FDMS — 1405F

Dichot — 1405D

Single — 1405
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etx_single.tar
checkv152

Note: A new file (“checkv152”) was added in the instrument firmware version 1.52.00
package from the prior release, so please include that when copying the files to the
USB device. This program is identical in all the variant sets.

5. IMPORTANT: For safety reasons, disconnect the AC power to the instrument.

6. The next steps are only for 1405 instruments that contain an old style of a circuit
board called an Interface board (most 1405 systems built in the year 2009 and prior
have an old style Interface board), so this step determines which style board is
present. If the firmware upgrade is being performed on an instrument with an old
style interface board, additional steps need to be performed first.

a. As shown in the figure below, unscrew the (4) screws on the front left side
of the 1405’s enclosure. The door should swing open allowing internal
access.

Figure 1 — Front Cover Screws
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b. Using the figure below as a guide, determine if there is a daughter board
present in the system. The daughterboard is located in-between the
Interface board below it and the CPU board (the CPU board is the board
with the Compact Flash card in it) above it. If the daughterboard is NOT
present as is shown, that means that the Interface board is a new style
board, skip ahead to step 7 otherwise the Interface board is an old style
board so continue the steps in the sequence.

|

AR £ 98 o =

_daughter board present means old interféé_e board

Lo 5]

Figure 2 — Daughter Board and Old Interface Board

7. [Old style interface board present] Here a jumper needs to be installed because
without the jumper the old style interface board won’t supply USB power until after
the system fully boots, so USB-based firmware updates won't work.

The jumper plug is a small plastic-encased shunt used to jumper two pins together
on a circuit board. If no spare jumper plugs are otherwise available, one of the other
jumper plugs that are normally present on the Interface board may be borrowed for
this purpose, and these instructions include that step (if one is otherwise available,
skip ahead to the next numbered step).

A good jumper-plug candidate for this purpose is the Analog Output jumper 8 (called
USEROUTS8) which may not be used in many installations unless all the analog
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outputs are in use (or one or more are in use but some are skipped and the last one
is used). Even if it's in use, it can be temporarily borrowed for the USB-based
firmware update procedure and then returned afterwards — remember to re-install it
after though, the procedure will remind you). The following steps assume that the
USEROUTS8 jumper is being borrowed.

Locate the USEROUTS8 jumper as shown in the picture below and remove it by
grasping it with two fingers and pulling it up.
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Figure 3 — Jumper USEROUTS8

8. [Old style interface board present] Install the jumper plug into the JP501 location as
described below.

a. First, become familiar with the instrument’s layout by using the picture
below. Identify the general area that the JP501 jumper plug can be found.
Look towards the center of the Interface board, in-between the small silver
colored battery and the yellow relay.
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- look in-between the battery N
yellow relay to locate JP501 |

: il
Figure 4 - Jumper JP501 (wide view)
b. Next, locate the exact position of JP501 using the following picture.

c. Finally, grasp the jumper plug using two fingers, find the open end of the
jumper plug, and reach in and install it on JP501 by placing the open end
over the pins and then pushing down on it.
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9.

Insert the USB stick into the USB connector on the front of the instrument. The USB
connector is on the left side of the instrument when facing the front of the instrument,
next to the RS-232 connector.

If the front of the unit is inaccessible, there is another USB connector on the rear of
the instrument which may be used. This connector is on the lower right side of the
instrument when facing the rear of the instrument, directly above the Ethernet
connector.

10.Re-connect AC Power to the instrument and power the instrument on. The USB-

based firmware update procedure is automatic and will take approximately 10
minutes to complete, however it is strongly recommended that upgrade is watched
because at the end the USB stick needs to be removed (If it is not removed, it will
attempt to upgrade again. If this happens, allow it to complete the upgrade if it has
already begun and watch closely the second time for the USB stick removal
message, or if it has not yet started the upgrade, power the instrument off when it
says to cancel the 2" upgrade). The on-screen instructions will display what it is
doing at each step and some steps may take several minutes to complete. If the
update script displays a message saying a necessary file is missing, it will inform the
user with a “file not found” message at which time the instrument should be
powered off and the files checked.

IMPORTANT: do not power off the instrument while the firmware update is in
progress or the instrument may not operate boot or operate correctly afterwards.

There is a small window of time before the actual upgrade process starts and it will
allow powering off the instrument to cancel the update before it actually begins.

11.As described above, remove the USB stick when the firmware update complete and

you are prompted to do so.

12.The instrument should reboot automatically and the new firmware should be running

when it starts up. To confirm the version of firmware that the instrument is running,
see on the “Instrument Status” screen that the “Instrument firmware version”
field shows “1.72".

Note: Once the instrument restart after the instrument firmware update, most
installations will see an automatic firmware update for one of the circuit boards. This
is because version 01.72.00 contains an embedded instrument firmware update for
one of the circuit boards, an update to firmware 0.014 for the 1/0O board. See the end
of the Overview section above about board firmware updates and be sure not to
interrupt the firmware update.

13.[OId style interface board present. If a customer-supplied jumper plug was used and

there was no need to borrow one off the 1405’s Interface board, skip ahead to the
next numbered step]. Once the new firmware has been verified, the jumper that has
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been temporarily installed on JP501 needs to be removed and put back onto the
pins it was borrowed from.

To restore the jumper plug, follow these steps:

a. IMPORTANT, for safety, power off the instrument and disconnect the AC
power to the instrument.

b. Reach into the instrument and remove the jumper plug installed on JP501
earlier in this procedure by grasping it with two fingers and pulling up on it.

c. Locate the jumper pins that the jumper plug was removed from earlier
These would be USEROUTS if the pins suggested in this procedure were
utilized. Place the open end of the jumper plug on top of the USEROUTS8
pins and push down until it reaches the base of the pins.

d. Skip to step 15 below.

14. IMPORTANT, for safety, power off the instrument and disconnect the AC power to

the instrument.

15.Re-install the front panel screws that were removed in the step above.
16.Reconnect AC power to the instrument and power the instrument back on if desired.
EPORT VERSION 1.4.1 - RELEASE NOTES AND INSTALLATION INSTRUCTIONS

ePort version 1.4.1 provides support for backing up and restoring the touchscreen
type and calibration configuration across future instrument firmware updates. It also
provides preliminary Windows 64-bit support.

The only change that ePort version 1.4.0 has relative to version 1.3.0 is that it
provides support for customer-defined instrument variable orderings when used with
a 1405 instrument that supports it that feature (instrument firmware version 1.51.00
or greater, see the instrument firmware release notes above). So after an ordering
has been setup on the instrument using the Data Storage screen on the instrument’s
graphical user interface, the ePort “Download Data” feature will retrieve a data file
that contains the desired column ordering.

ePort install/lupdate instructions:

If a previous version of ePort is already installed, uninstall it before installing this
version. Uninstall it by going into the Windows Control Panel, selecting the ePort
program and then clicking the Remove button. When the program remove
completes, close the “Add or Remove Programs” window and close the Control
Panel utility.

Locate the ePort version 1.4.1 installer program called “ePort_Setup_1 4 1.exe”.
Either a Thermo Scientific 1405 CD (requested from Thermo Scientific Technical
Service) or a file downloaded from the Thermo Scientific Air Quality Instruments
Online Library may be used.

On Windows, click start > Run. On the Run dialog box, click the Browse button
then navigate to where the ePort installer program is, click it to select it, then click
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Open button. Back on the Run dialog box, click the OK button to run it and the
Install Shield Wizard should run.

Click Next, then read and accept the license agreement if it is acceptable and click
the Next button.

Be sure to follow the notes on the next screen about requirements. If the
requirements are not satisfied, click Cancel to exit the ePort installer, update the
system to meet the requirements, then restart this procedure at step 2. If the
requirements are met, click the Next button.

Fill in the User Name and Organization data fields, select the appropriate user install
option and click the Next button.

. The install process will be ready to begin, click the Install button to start it.

When the Install Shield Wizard completes, click the Finish button.

RPCOMM VERSION 2.1.0 - RELEASE NOTES AND INSTALLATION INSTRUCTIONS

The only change that RPComm version 2.1.0 has relative to version 2.0.0 is that it
provides support for customer-defined instrument variable orderings when used with
a 1405 instrument that supports it that feature (instrument firmware version 1.51.00
or greater, see the instrument firmware release notes above). So after an ordering
has been setup on the instrument using the Data Storage screen on the instrument’s
graphical user interface, the RPComm “Download Data” feature will retrieve a data
file that contains the desired column ordering.

RPComm install/update instructions:

1.

If a previous version of RPComm is already installed, uninstall it before installing this
version. Uninstall it by going into the control panel and selecting the RPComm
program and click the Change/Remove button. When the program remove
completes, close the Add or Remove Programs window and close the Control Panel.

Note: The uninstall process will leave any files that weren’t part of the original
package such as newer register configuration files, but you may wish to backup
those files manually (these get installed into the “C:\Program
Files\RPCO\RPComm” directory by default). After the install, the newer RPComm
directory should contain all the latest register configuration files for all supported
Thermo Scientific instruments as of the software creation date.

Locate the RPComm version 2.1.0 installer program called
“RPComm_2 1 setup.exe”. Either a Thermo Scientific 1405 CD (requested from
Thermo Scientific Technical Service) or a file downloaded from the Thermo Scientific
Air Quality Instruments Online Library may be used.
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On Windows, click start > Run. On the Run dialog box, click the Browse button
then navigate to where the RPComm installer program is, click it to select it, then
click Open button. Back on the Run dialog box, click the OK button to run it and the
Install Shield Wizard should run.

Click Next, read and accept the license agreement, then click the Next button.

Fill in the User Name and Organization data fields, select the appropriate user install
option and click the Next button.

Use the default installation destination folder or change it and click the Next button.
The install process will be ready to begin, click the Install button to start it.

When the Install Shield Wizard completes, click the Finish button.

Go to the "RPCOMM - CONFIGURATION FILE INSTALLATION” section below in

order ensure the latest 1405 instrument register file matching the instrument
firmware gets installed, if desired.

RPCOMM - CONFIGURATION FILE INSTALLATION

A new RPComm 1405 register configuration file corresponding to this particular
instrument firmware release is provided. Installation of this new configuration file only
requires a manual copy of the file into the proper installation directory so RPComm will
recognize and utilize it when connecting to an instrument.

1.

Open Windows Explorer and navigate to the directory where the firmware package
was extracted, for example, “C\TEMP”.

Locate the file called “RP14051.72", right click it, and select “Copy”. The filename
convention used with the configuration files is “RP” then the model then the version,
truncated to version 1.72 (refers to version 1.72.00) in this case.

Using Windows Explorer, navigate to the installation directory for RPComm (This
corresponds to the directory where program file RPComm.exe was installed). If the
default installation directory was used, it would be something like
“C:\Program Files\RPCO\RPComm”. Right click on a blank area within the file pane
on the right side, and select “Paste”. You should see Windows copy the file into the
current directory.

To see if the new register file is recognized, connect a cable from the PC the
instrument, open RPComm, and create a new connection for a 1405 instrument (“File”
> “New Connection” > “1405”, then click “OK”). This should create a new connection
line, click it to highlight it then click the “Connect to selected instrument” icon. A
window should appear with a title that includes the string “version 1.72” in it and the
1405-specific registers should appear in the right-side pane.
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INSTRUMENT NETWORK CONFIGURATION

To connect the 1405 instrument to the network, begin by plugging in a 10/100 Ethernet
cable into the instrument's Ethernet connector, on the back of the instrument. The
orange LED’s built-into the Ethernet connector should begin blinking if the connection is
active, so if the LED’s are not blinking check that the network connection is activated.

To configure the instrument to work over the network, use the Network Configuration
screen on the instrument, which is accessed by selecting “Settings” > “System” >
“Network Configuration”. There are two ways to configure it, automatic IP addresses
(which uses a DHCP server) or specify the IP address (which uses a static or reserved
IP address), options for these settings are on this screen, select the desired option.

If you are using automatic IP addresses, and you are connecting the instrument to a
router on a local network segment, make sure the router provides a DHCP service and
that it is enabled. If you are connecting the instrument to a Local Area Network, make
sure that there is a server on the network that provides a DHCP service.

If you are using a specified IP address, you will need to enter in the network parameters
for “IP address” and “subnet mask” fields. Check with your system administrator if you
are unsure of the network parameters to use.

If you make a change to any setting on the “Network Configuration” screen, reboot the
instrument to make sure the settings take effect.

When the instrument is recognized on the network, the “System Status” screen on the
instrument should show a valid IP address in the “IP address” field, and ePort should
recognize it.

If a router-less configuration between a PC or laptop and the instrument is being used,
an Ethernet “cross-over” cable is required, and a static IP address needs to be assigned
on the instrument. The firmware update process using ePort software will be the same
in this configuration. See a Thermo Scientific Tech Note on this topic for the
instructions.

— END —
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